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10QSOLogger is a special purpose logging system designed specifically for the Ten-Ten International 
QSO parties that are held throughout the year. It is a small, lightweight and simple program that will 
log contacts, check for duplicate contacts based on the QSO party rules, automatically calculate 
points, score, and process a log for submission to the QSO party manager in addition to a dupe sheet. 
It will run on Windows, Linux or MAC as it is Java based and not platform specific.  The program can 
also be used as a general purpose logging facility and award tracker for the basic 10-10 awards such as 
Bars, WAS, WAC,...etc.  Use as a General Logger will be discussed at the end of this document.

Additionally, it will export an ADIF formatted file for importation into the users standard logging 
system, send a submission to eQSL or LOTW (Logbook of the World), and lookup a call sign using the 
Hamcall Remote server, FCCLookup, QRZ XML service, QRZ CD or the Buckmaster CD. 

Program Installation: Installation or updates to the program are simple.  Obtain the 10QSOLogger zip 
file from the website and install the file to your computer.  If you are updating to a later revision, there 
is no need to uninstall a previous version, just write over the top of the existing installation.  The 
update process will not destroy any data you have created.  The program also provides an option from 
the Help menu to allow you to check for an update and optionally download and install the new 
update. (this feature has not been implemented in the development version)

There is no default location to install the program as the installation is distributed in a ZIP archive.  The 
installation path is left up to the user.  Launching the program is quite simple.  On a Windows machine 
you can just double click the 10qsologger.jar file or use the provided batch file.  Just make sure the 
launch directory is the installation folder when you create your shot cut.  On Linux and Mac you simply 
launch the 10qsologger.sh script file. (NOTE:  you may have to make that file executable).

How to use the program:

To create a New Contest or QSO party log, Select File | New from the file menu.  The Setup Dialog will 



open for you to fill out.

To open an existing QSO party log, select File | Open from the file menu.  The program will read in a 
list of the available logs that have not been processed for submission.  A list of those available logs will 
be displayed:

Click on the name of the log you want to use.  You 
will notice that I have logs for myself and  another 
in this database.  The beauty of this system is that 
you can store any number of logs for the same 
QSO party as long as the call sign is different.  You 
can run multiple instances of the program on the 
same computer, accessing different logs.

If for some reason you want to remove a log that 
has already been processed, Select File | Remove 

Processed Log.  You will get a list of those logs that have been processed.  Click on the log you want to 
remove.  NOTE:  This action is permanent and will remove that table from the database.  

Update Data Files:  Select this menu item to update the 10-10, VP, EPC and 
070 data.  It will pull the most 
recent update file from my web 
host.  The web host file is usually 
updated on a monthly basis and a 

few days prior to a QSO party.

Creating a New QSO Party Log:

Fill in all the required data for each of the fields.  Each 
of the currently approved QSO parties is listed in 



the Contest drop down box.  All of the common modes are listed in the Mode dropdown Box. Addition 
of new modes and QSO parties can be accomplished by the user.  Please refer to Appendix 1, Technical 
Information.
 
The Personal Information you enter here is the information that will be used when processing a QSO 
party.  NOTE:  While the VP number is recorded here, it is not necessary at this time, but may be used 
for future QSO parties. 

Save/Recall Info Buttons:  Click the save button and you can save all your personal information to a 
file for recall when creating another log.  It is best to save this in your home directory for easy 
retrieval.

Lookup Database:  If you want to use one of the available look-up databases, select one of the 
options, otherwise select none.  

QRZ XML is a subscription service offed by QRZ and will require you to enter a user ID and password. 
You will also need an internet connection.  QRZ and Buckmaster CD's must have the CD installed in the 
FIRST CD drive if you have multiple drives.  Hamcall(RMT) and Hamcall(LCL) identify the HamCall 
Search Program.  If you do not have this software installed on your computer locally, do not select the 
LCL option.  The Remote option will access the data from the Hamcall Server on my Linux Server.  This 
data is updated on a weekly basis.  FCCLookup is for Version 5.x of the software.  This software will not 
function correctly with previous version.  You are encouraged to update your older FCCLookup 
software to the latest version. (NOTE:  In this development version, the CD options, FCCLookup and 
QRZXML have not been implemented.)

Click the OK button to save this record into the database.  You can edit any of this data, with the 
exception of the Contest Name anytime you have the log open by selecting Options | Setup.

Logging Contacts:  Enter the call sign of the station, the operators name, the ten-ten number if 
available ( 070 and EPC numbers for the Open Season event) and the location of the station in the 
fields provided. If the station is a US station, click the US button and select the State from the drop 
down box.  If the station is outside of the US ( Alaska and Hawaii are US States and DX entities and you 
can log these either as a US state or a DX country), click the DX button and select the country from the 
drop down box.  DO NOT attempt to edit the location name.  The country names are the official ARRL 
names for each of the DXCC entities and is used when exporting the log to ADIF to pull the correct 
DXCC identifier number. A spot to record the VP number is available and that number will be stored in 
the database for export to the ADIF file.  Likewise, the user can enter the county for all events.  The 
comments section and the mobile check box will only be useful when using the General Logging 
option.

Real-time vs Offline Logging:  The program is normally in the real-time logging mode, this means that 
when you click the log button, the current date and time will be recorded in the database.  But, if you 
hand log, then want to enter the contact after the fact, you will need to select Off-Line Logging from 
the Options Menu.  When selected, the Date and Time entries will be enable to allow the user to 
enter a date and time for each contact.  Dates must be entered in the format of YYYY-MM-DD and 
time must be in the format of HH:MM.  Remember to use UTC time for all contacts as that is what the 



contest processor is expecting.

Auto Lookup and Auto Fill:  If you elect to use these features, be cautious of the information as things 
can change from update to update.  If the name of the registered user of a call sign is Robert, but the 
individual is using Jim or Bob on the air, make sure you log what was passed.

Once you have all the necessary contact information, press the log button to place the contact into 
the log.  If for some reason the contact is not a good contact then before you click the log button, you 
can click the Clear Button to clear all of the log fields.

 Duplicate Contacts:  This software has two methods of handling duplicate contacts. The first is an 
ongoing check.  With each alphanumeric character you enter into the call sign field, a lookup of call 
signs is performed, based on the characters that have been entered into the call sign box.  For 
instance, you type the letter K.  The returned list of matching call signs will appear under the Dupe 
tab.  As you type more characters the list will be further parsed down until you either hit upon a call 
sign or the list is blank.  This method gives the user a quick look to see if they have already worked the 
station in question.

If you enter a call sign that has already been logged and press the tab key to move away from the call 
sign field, or click into any other field with the mouse, the second dupe checking method will run and 
produce a message box telling you that the call has already been worked.  The program will not allow 
you to enter a duplicate contact. Duplicate processing is not enable when you have selected a General 
Log.

Scoring: As contacts are entered into the log, they are scored for points based on the regular point 
schedule for the specific QSO party – 2 points for contacts with a Ten-Ten number and one point or 
those without.  In the event of the Open Season event, you get an additional point for an EPC number 
and another point for an 070 number for a maximum possible of 4 points.  The point value is stored 
with each contact and added to the total points.  The status bar will display the number of contacts 
you have with 10-10 numbers,  the total without a 10-10 number and the total points accumulated so 
far.

Processing a Log:  When the QSO Party has ended, you will want to process the log for submission to 
the QSO Party Manager.  Select Options | Process Contest.  A standard File Save dialog will open to 
allow the user to specify where to save the processed files.  The default will be the user home folder. 
A default file name will also be suggested and it is recommended you use this default name.  It will be 

the same name as the QSO party table name.  Click the OK button to 
accept the file name and the program will process the log and create a 
file with an extension of .log which will be the submission
 file and a file with an extension of .dup which is the dupe check file. 
You will then be given the option of creating an ADIF formatted file.  If 
you select this option, that file will be created in the same location with 
an extension of .adif

You can now send the .log and .dup file to the QSO party manger and 



use the .ADIF file for import into your general logging system, and upload them to eQSL and LOTW. 
This ADIF formatted file can alps be imported into a General Log.

The ADIF file that is created uses the version 1.0 specification and will use the tags for the 10-10, VP, 
EPC and 070 numbers.  Not all logging programs will recognize these tags so the 10-10, VP, EPC and 
070 numbers will also appear in the general comment field so you have these numbers in your log.

Display and edit a log:  To display the complete log and edit the data, Click Options | Display Log.  You 
will get a Dialog that shows the log in a standard column format with the names of the fields at the 
top and each contact or entry on a separate line. If your version of the software is showing a column 
called “pkey”, do not, under any circumstances, make any edits into this column.  This is the databases 
primary key and it is this data that uniquely identifies the record.  It will normally start at 1 and 
increase by one, unless a row has been deleted somewhere along the way.

The user must take great care when editing data in this table.  If you leave the date, time, call, mode, 
name or QTH filed blank or empty, you may receive a dbNULL exception error.  These fields cannot be 
a null value.  You must have an entry as these are the same minimum requirements for the contact to 
be considered a good contact.  The columns for TenTen, VP, Mobile, DXCC, EPC and 070 are numeric in 
nature and if a number is not assigned, then the value will default to 0.  The DXCC column is the 
number that as been assigned by the ARRl for this DX entity.  The US will be 291 and Canada is 1.  This 
column will always contain a number that is automatically generated by the software. Columns Bar 
Submit, Digital Submit and County Submit are used in the award tracking for the General Logging 
functions.  They are ignored and default to 0 for all events other than a General Log.  Pay particular 
attention to the format of the date and time.  Any other format you use will result in export errors in 
the processed files and the ADIF export.

To edit a value, click on the cell that contains the value to be edited.  The row tune blue as the 
highlighted data in the graphic shown above.  Click the cell again and the individual data will be 
highlighted only.  You can now edit the data in that cell.  Note:  If you delete data from the 10-10, EPC 
or 070 columns, you will have to manually recalculate the points for that specific call sign.  You can 
delete an entire row by selecting the entire row, then click the Trash Can icon on the tool bar.  

Changes are committed to the database when you type a return inside of the field or you move away 
from the field.



You can filter the display records by using the filter options.  Enter the data you would like to filter on 
in the filter text box, AZ if you want to filter on the state of Arizona.  Select _qth from the drop down 
box of column names.  Click the Filter Off button to turn on the filter.  The log will now only display 
those records that match the filter.  To turn the filter off and display all the records again, click the 
Filter button to turn it off.  You will note that the drop down box of column name differ slightly from 
the column header text.  The name in the drop down box are the actual names of the fields in the 
database.

You can sort the table by clicking on the header of any column and the table will be sorted by the 
values in that column.  Click the header once and it will sort in ascending order.  Click it again and it 
will sort in descending order.  The sorting alogrythm is alphanumeric in nature with the exception of 
those fields that are defined as integer values, then those fields will sort in numerical order.

The only values allowed in the Mobile, Bar Submit, Digital Submit and County Submit are 0 and 1 
where 0 is false and 1 is true.

Display Menu:
 This menu allows the user to define the default display font, and 
the foreground color ( color of the text ) and the color of the 
background.  The definitions will be applied to all other windows 
and forms and saved as a default and recalled when the the 
program is launched.  The dialogs displayed for font and color selection will differ depending on your 
operating system.  Be careful of Thrid-Party fonts you have installed as these may not render correctly 
in Java.

Look and Feel Menu:
Java look and feel is similar to a Windows Theme.  The selections you 
have are platform dependent, but all platform will provide you with 
Java's defaults of Metal, Nimbus and CDE/Motif.  In this case I have 
selected the standard Windows as the defualt Look and feel.  Nimbus is 
a very nice theme, but beware that it does not always follow Java and 
platform specifics when dealing with sizing of components.  Experiment 
with the selection until you find a theme that suites your needs.  There 

are custom Look and Feels that can be loaded, but I do not guarantee these are compliant with Java 
standards.

General Log: This software can also be used as a general purpose log for all of your 10-10 contacts.  It 
will also support tracking of the basic 10-10 awards.  This program is not designed to track any type of 
Chapter awards and certificates.  This is best tracked using a spreadsheet as these awards are 
constantly changing.

To create a General Log, Click File | New and instead of selecting one of the contest listings in the 
event drop down box, select General Log.  Fill in the personal information as you did with one of the 
contest and the remainder of the setup dialog then click OK to create the log.  A new table with the 
call sign and General_Log will be create in the database.  You can create as many General Logs as you 



wish, but when you create the initial log, do not use a call sign that has already been used.  You can 
type anything you wish in the call sign box to create the General Log, then after you created the log 
and selected it, you can come back to the setup and change the call sign to whatever you wish.

Logging contacts in the General Log is just like logging contacts with a contest except that there is no 
duplicate processing or point calculation.  As indicated previously, Hawaii and Alaska can be logged as 
a US State or a DX entity.  It is highly recommend that you log each of these at least once as a US state 
to get credit towards the Worked All State Award, and once as a DX entity for credit for the Countries 
award.  If you are chasing US Counties, then once you have logged these as DX entities, log them as US 
states so you can also log the county.

If you have contacts in another logging program, you can import those into the General Log using the 
ADIF Import option on the File Menu.  This process is somewhat slower than other programs because 
it checks for and automatically eliminates duplicate contacts.  If you other logging program record the 
10-10 number, then it should be exported in the file as an ADIF tag.  The VP, EPC and 070 number do 
not have a defined ADIF tag.  As such, many programs will export these in the comment field.  If these 
are exported, similar to the following, the import function will try to pick these out.

VP:1234 EPC:547 070:12445

As long as each entity is separated by a space or tab character and the tag and number are separated 
by a colon ( : ), those numbers will be processed and entered into the log.  I have checked the import 
routine with a few ADIF outputs from Program such as Win1010, DX4Win and a couple of others and 
they import correctly.  But, the specification is constantly changing.  If you have an error when 
importing contacts, try to send me as much information as possible about the error, along with a 
sample of the ADIF file you are trying to import.

ADIF files that have been created with the contest mode of this program can also be imported into 
your general log.

Awards: The program will track and process the basic awards for Ten-Ten International.  This 
development version as the capability to process awards for WAS, DX, Counties, and Bars to include 
the new digital awards.  Simply select the award from the main menu and an Award Dialog similar to 
the graphic below will be displayed.



In this case we have the WAS dialog for the Digital Award. 
It shows that I have worked 28 US States along with a 
listing of those states I have not worked.  The listing is in 
alphabetical order by the US state abbreviation.  The SQL 
script used to define this table selects any mode that is 
not SSB, FM, AM or CW as a digital mode.  It also limits 
the requested set of rows to those contacts after August 
1, 2006.  Once you have all 50 states worked, press the 
button to export a file you can send to the awards 
managers.  The basic WAS award for Ten-Ten works the same, but does not limit contacts by mode or 
date worked.  The award dialog for DX countries works exactly the same as the WAS dialog.

Working with bar awards is a bit more difficult and time consuming by nature of the award.  This 
program will track the bar awards, but will require some initial work to identify those ten-ten numbers 
you have already submitted.  The database has fields called bar_submitted and digital_submitted 
which are used to determine which ten-ten numbers have been submitted for bar awards.  When a 
ten-ten number is submitted for a bar award, the submitted field will be tagged with a 1.  If you have 
worked that ten-ten number more than once, all entries with that ten-ten number will be tagged with 
a 1.

The easiest method to initially setup your bar award 
tracking is to import a list of ten-ten numbers that you 
have already submitted. Create a simple text file with one 
ten-ten number on a line. Once you have all those 
number in a file, you can import them using the import 
button in the lower right corner of the Bar Award Dialog. 
Once that function is complete, clause the Bar Award 
Dialog, and open it again.  You should see something 
similar to the graphic on the left.  In this case, the 

individual has submitted 500 ten-ten numbers for the Bar Award, but has another 661 unique 
numbers outstanding.  The current view, if you use the scroll bar, shows all of the remaining unique 
numbers you have not submitted, ordered by the date worked.

To create a submission for the next 100 numbers, select a line number to start with in the box titled, 
“Select line number to start with”.  Normally this will be 1.  Press the enter key and the table will filter 
out everything except the next 100 numbers. Click the button “Export to file for award submittal” and 
a submission file will be created in ten-ten number order.  This process will also iterate over the 
database and set the submitted flags for those ten-ten numbers.  This process will take some time so 
be patient and wait for the process complete message.  If you are going to create multiple files for 
submission of more than one bar award, make sure you give the file a unique name which describes 
the purpose of the file.

The Digital Bar award works exactly the same, but the query of ten-ten numbers is base on the mode, 
a contact date after the commencement of the award and the digital_submitted flag.

The US County award is similar to the WAS and DX award dialogs.  The query is based on a unique US 



state and county and a ten-ten number that is not 0.

In this graphic, the user as already submitted 300 
counties to the awards manager and still has 234 counties 
worked that have not been submitted.  Clicking the 
Export button will create a submission file of the next 100 
contacts, start from the first contact in the table.  It will 
then update the submission flag for those counties in the 
log.  As you work counties, if you have already submitted 
that county for the award, the software will automatically 
update the submission flag when the contact has been logged.  As with the bar awards, if you have 
already submitted counties for the award, then you will need to initially set the submission flags for 
those counties you have already submitted.  Again, the easiest way to accomplish this is to create a 
text file with all of the counties you have worked in the following format:

state,county

where the state is the 2 letter identifier for the state followed by the official county name separated 
by a comma.  One entry per line.   Click the import button to import this file.  Be patient as this will 
take some time especially if you already have quite a few counties worked.  You will get a Completed 
message dialog when the import process has competed.



Appendix 1 – Technical Specifications

This software is built using Java and will require you to have a runtime version of Java installed on yoru 
machine, version 1.6 or better.  There are a number of Java runtimes out there and as long as they 
support Sun 1.6 or better you should be good to go.  To check your version number, at a command line 
type: java -version

The underlying database used to store all this data is called SQLite.  It is similar to MySQl or MSSQL, 
but it does not require the user to install a separate database server.  The server itself is contained in 
library assembly file (.jar)  making it much easier on the developer.  You can obtain the command line 
utilities from the SQLite Web site if you want to manipulate the data outside of the program.

There are a few GUI programs that can be used to access the database files.

SQLite Expert – my personal favorite for the Windows platform.  Comes in a free and Pro (pay) version.

SQLite2009 Pro Enterprise Manager – SQLite2009 Pro Enterprise Manager is a freeware tool that 
enables you to manage your SQLite3 databases. Not only that, you can use this tool for learning and 
working with LUA programming language. LUA is a powerful, fast, lightweight, embeddable scripting 
language. 

Any SQL Maestro – is the premier multi-purpose tool for database management, control and 
development. It allows you to administer any database engine accessible via ODBC driver or OLE DB 
provider (SQLite, MySQL, Oracle, SQL Server, Access, and so on). AnySQL Maestro has been 
successfully tested with the SQLite ODBC driver and all the latest SQLite versions. 

SQLiteMan – The best developer's and/or admin's GUI tool for Sqlite3 in the world (so they say).

SQlite Studio – SQLiteStudio is an advanced, cross-platform SQLite database manager. 

SQLite Administrator – SQLite Administrator is a powerful tool if you easily want to create, design or 
administrate SQLite database files. The SQL code editor helps you to quickly write sql queries with 
features such as code completion and highlighting. Both major versions of SQLite database files are 
supported by SQLite Administrator.   This is one I have used in the past.

There are a number of other programs free and fee based that will manage SQLite databases.  You can 
find them at this website.

There are two database files the program depends on.  logs.db and config.db and will be found in your 
home directory in a folder called \.10qsolog.  NOTE:  This folder name begins with a period and will 
signify a hidden folder on most operating systems.  You will have to enable your file manager to show 
hidden files.

http://www.sqlite.org/
http://www.sqlite.org/cvstrac/wiki?p=ManagementTools
http://sqliteadmin.orbmu2k.de/
http://sqlitestudio.one.pl/index.rvt
http://sqliteman.com/
http://www.ch-werner.de/sqliteodbc/
http://www.sqlmaestro.com/products/anysql/maestro/
http://link.osenxpsuite.net/?uid=homepage&id=sqlite2009pro.zip
http://www.sqliteexpert.com/
http://www.sqlite.org/


Config.db contains the following tables:

Contest:  contains the names of the approved QSO parties

Country:  contains the list of all of the DXCC countries, current and deleted along with their designated 
prefix, latitude and longitude, zone, DXCC country  number, and deleted status.

County: contains a list of all the US counties by state and their latitude and longitude.  NOTE:  this 
table is not currently being used, but will be in a later revision.
Modes:  contains a list of all the operating modes.

Prefix:  contains a list of prefixes that have been used by a country and maps them to the countries 
designated prefix from the Country table.

State:  contains a list of the US states by their 2 letter abbreviation, name and a latitude and longitude.

Logs.db  Will contain a table called config and a table for each contest you create.  The config table 
contains the setup data for each contest/QSO party you create.

Manipulating the database with any of these GUI tool makes administration very simple, but if you are 
unfamiliar with database management systems in general, proceed with caution as you could 
completely destroy your database files in a matter of a microsecond.  Make sure you have backup 
copies of these files if you decide to manipulate these files with any third-party tool.


